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Introduction
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Introduction
The Reports application generates numerous reports about contact center queues, agents, and inbound calls.
Reports enable users to analyze how queues and agents are handling customer contacts, and review general system
operation and call frequency or duration.
The reports are divided into the following categories:
•
•
•
•
•
•
•

Detailed Queuing Reports = Very specific information on every queue call.
Historical Queuing Reports = Summarized information on queue calls.
Voice Messaging Reports = Overview of voicemail and mailbox use information.
Console Reports = Overview of operator calls and Console use information.
Fax Reports = Overview of information about inbound and outbound fax usage.
System Reports = Overview of the CTI server system setup from the Administrator.
Personal Reports = Allows the saving of commonly-used reports with all setup parameters.

This guide provides step-by-step instructions on how to use the Reports product.

Log In and Out of Reports
Log into Reports
1.

On the PC’s Desktop, double-click the Reports shortcut icon.

2.

In the Name field, type your full name (your name may automatically display after typing a few letters).

3.

In the PIN field, type the PIN number (this is the same PIN used to access other applications (e.g., Desktop or the
personal mailbox).

4.

Optional: Click the Remember Me Next Time option to save this login information for the next time you start
Desktop.
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Log Out of Reports


Use any of the following methods to log out of Reports:
•
•
•

Click the Close button (the red X in the upper right-side of Reports).
From the File menu, select Exit.
Press Alt + F4.

The Reports Interface
The Reports interface provides complete information about menus, toolbar options, and current report displays.
Toolbar

Company List

Media List

Report Groups

Report/Graph View

Item

Description

Toolbar

Provides shortcuts to the most common Report actions.

Company list

Select a company to limit the reports with data from that company.

Media list

Select a media type to report on (such as phone or email calls).

Report Groups

Groups the reports so they are easy to find.

Report/Graph View section

Displays the generated report/graph.
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Toolbar Icons
The following table lists the frequently-used functions in Reports.
Icon

Name

Description

Open

Opens a report that has been previously saved (in .qrp format).

Save

Saves a report as a .csv or .qrp file.

Print

Prints the current report or graph.

Report Wizard

Use for assistance when creating a report.

Report Parameters Use to select all regular and advanced parameters for the current report.

The Report Tab
Click the Reports tab to display a tabulated view of the report data.

Item

Name

Description

Arrows

Use to navigate between pages in a multi-page report.

Zoom

Use to enlarge or reduce the screen view of the report.

Fit

Use to select the full page, text width, or full-size report views.
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Right-Click Menu


Right-click within a report to quickly and easily:

•
•

Resize the report.
Refresh the report, ensuring that up-to-date information displays.

Online Help
Reports include online help for each report.


Use any of the following methods to open the online help:
•
•

Press F1.
From the Help menu, select Using Reports.
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The Top Contact Center Reports
Detailed Queue Reports (Top 5)
Report

Description

Queue Performance

Helps to:
• Evaluate the contact center performance on a call volume per-queue basis.
• Determine how well the target answering time for the contact center is being met by
viewing daily averages and totals for each queue.

Queue Traffic Analysis

Provides an overview of queue activity for a contact center; specifically call frequency,
call wait time and length, and abandoned calls. Use this report to analyze queue traffic
to determine the busy and quiet times for the contact center.

Queue Transferred Calls

Identifies incoming calls transferred to another destination. The calls are grouped by
transfer destination (e.g., all calls transferred to extension 5555 are grouped together).
This report is run in summary mode by default.

X-Seconds

Provides an alternative report of the queue performance by totaling call wait times into
time slots. Use this report to measure queue performance based on an unacceptable
wait time in the queue. This report is also helpful for analyzing abandoned calls.

Wrapup

Lists every call and call subtotals with wrapup code information.

Detailed Agent Reports (Top 3)
Report

Description

Agent Performance

Examines the individual performance of the contact center agents. Daily averages and
totals for each agent and the details of each call helps you assist the agents reach
expected performance criteria and identify the top performers.

Agent Availability

Reviews the net availability of the agents. This report includes all actions that made
agents unavailable for calls (e.g., logged out on a break or worktime).

Agent Summary

Monitors the performance of the agents overall and in detail. Use this report to
summarize agent availability, call type, and call duration. Use the summary to aid with
training and procedure planning. This report provides a full breakdown of an agent's
shift.

Note: If the system has queues or agents operating in Reports, all times presented are local time according to
the time zone assigned to that queue or agent, rather than the time the call arrived at the CTI server. Refer to
the online help for more detailed explanations and examples.
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Create a Report


While logged into Reports, click the Wizard Report Parameters icon to launch a wizard to help define report
parameters and requirements.

Icon

Name

Description

Wizard Report Parameters

Best used for a first-time setup or when needing to reset all report
parameters.

Report Parameters

Best used after running the Wizard Report Parameters to quickly change
certain parameters before redisplaying the report data.

Report Parameters
This section describes how to set up report parameters to run either a queue-based or agent-based report.
1.

Click the Wizard Report Parameter icon.

2.

Click one of the following to set a date and time range for the report, and then click Next:
• Absolute Date to select a fixed start and finish date and time using the built-in calendar.
• Relative Date to select a standardized reporting period relative to today (e.g., today, yesterday, last week, or
last month).
• Custom Date to select a formula to define the period for the report.
Note: Wizard windows may change depending on the report being run. Refer to the online help for
report specific assistance.

3.

Select a time period and date range for the report, and then click Next.
Note: The default time period is 24 hours.

4.

Click either of the following items to include in the report, and then click Next.:
• Queues and/or Queue Report Groups for queue-based reports.
• Agents and/or Agent Report Groups for agent-based reports.

5.

Click a call type for the report, and then click Next. The most popular types are as follows:
• A—Abandon = Calls where the caller has hung up before being answered.
• Q—Queue = Calls that were delivered by the queue to an available agent.
Note: Click the Help button to access descriptions of the remaining call types.
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Select which abandoned calls to exclude and the detail level to be reported, and then click Next.
• To exclude abandoned calls, click the If the Call’s Abandon Time is Less than the Queue’s Minimum
Abandon Time option.
• A detail leveled report displays:
– All Details for a line of information per call, including summary and total lines.
–

Summary for summarized data per hour or daily, depending on configuration.

–

Totals Only for total line detail only.

–

Monthly Breakdown for monthly total lines only.

–

Report Interval to select a sampling period for the report breakdown.

Review the summary of the report’s parameters, and then click Run Report.

Call Type Glossary
The following table lists the call types that are recorded by the system. Many reports allow you to include or exclude
selected types from this list.
Note: Some reports are limited to certain call types. Some summary columns in the reports are calculated
based on particular types. Refer to the online help for details on each report.
Call Type

Description

1-9 = Callback attempts 1 to 9

Attempts to return a call after a callback has been lodged.

* = Callback attempts greater than 9

Tenth attempt (or higher) to return a call after a callback has been lodged.

A = Abandoned queue calls

Calls where the caller hung up before being answered.

C = Callback lodged

Incoming calls where the caller left details to be called back.

D = Answered direct call

Calls that came in directly to the agent's extension, not via the queue.

H = Hang-up mode applied to queue call Calls that the system hung up on (i.e., the mode action was set to
Hangup).
I = Interactive voice response

IVR

O = Outbound calls

Calls that the agent outdialed (i.e., outgoing, not incoming).

P = Picked [up] calls

Calls delivered to an agent who did not answer; a different agent dialing
PBX call pickup from another phone answered the calls.

Q = Queue call

Calls that were delivered by the queue.

R = Recalled call

Queue calls that the system pulled back into the queue after they were
unanswered at an agent’s extension.

T = Transferred call

Calls that were transferred to the agent's phone from a queue (i.e., the
mode action was set to Transfer).

U = Unanswered call

Non-queue calls that rang at a phone without being answered.

V = Voice Messaging call

Calls that were delivered to voice messaging.
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Managing the Reports
Reading Completed Reports
When a report generates, it displays the information in a tabulated format in the Report window.

Item

Description
Title or name of the report.
The parameters that have been used to generate this report.
Column headers.
Queue or agent information.
Report detail.
Summary data.

Report totals.

Print/Run/Open a Report


To print/run/open a report, click the Print icon (if printing, the report prints to the default printer).
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Save a Report
1.

Click the Save icon.

2.

Save it in either of the following formats:
• .qrp = A quick report file that saves the fully-formatted report exactly as it appears in the Reports
application. A .qrp file can be opened in Reports by selecting Open Report from the File menu.
• .csv = A comma separated file that saves the report data as text in a file. A .csv file can export the report
data to a third-party spreadsheet or database program.
• .pdf = A file that is viewed in Adobe Acrobat Reader (Reader is a free application distributed by Adobe
Systems at :http://get.adobe.com/reader).

The Graph Tab
Graphs are an additional Reports feature that transforms statistical reports into simple visual presentations. Graphs
can be generated from the report data, and are automatically scaled to fit the window and the printed page.
The following lists the only reports that can be used to create graphs.
Report

Description

Detailed Queue

• Performance
• Traffic Analysis
• Service Level

Detailed Agent

Performance

Historical Queue

• Queue Historical
• Queue Historical Average

Historical Agent

• Agent Historical
• Agent Historical Average

Presence

Presence Activity

Create a Graph
1.

Create and run the selected report.

2.

Click the Graph tab.

3.

From the Graph Type list, select the graph type. Only available graph types display.

4.

From the Duration Type list, select the duration type. Only available duration periods display.

5.

Optional: Click the 3D Graph option to display the graph in three-dimension.

Graph Types Options
Refer to the online help for details on the different graph types.

Graph Duration/Intervals Options
Refer to the online help for details on the different duration periods.
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Personal Reports
Personal reports are reports that are run on a regular basis with the same parameters, and do not need to be
configured each time. All the selected report parameters are saved and can even be scheduled to run automatically
on a regular basis.

Create a Personal Report
1.

Click the Personal group.

2.

Right-click in the grey area below the Personal group, and then select the report type from the menu.

3.

Follow the steps in the wizard to customize the report’s parameters.

4.

The customized report is saved in the Personal group.
Notes:
• Alias = A suitable name for the report.
• Date = Use the Relative date (yesterday, last week, etc.).
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Schedule the Personal Report
The Scheduled Report Wizard can help schedule any Personal report to run automatically. The generated report can
be saved to a disk, emailed to particular people, or printed automatically.
1.

Create a Personal report (see ”Create a Personal Report” on page 10).

2.

From the Tools menu, select Scheduler.

3.

Use either of the following methods to start the wizard:
• From the File menu, select Add.
• Right-click a personal report, and then select Add.

4.

Click the report(s) to schedule, and then click Next.

5.

Set up the batch file information, and then click Next.
a.

In the Output Directory field, Browse to the Location where the report is to be save (the location can be
local or on a network).

b.

Click the Email Reports option to email the completed report to other users.

c.

In the File Type section, click the type of file that the report is to save as. When the report is saved as a:

• QRP file, the report needs the Reports application to view.
• CSV file, the report can be opened by many third-party applications.
6.

In the Task Name field, type the name for this scheduled report (can be the same as the personal report’s name),
and then click Next.

7.

Click how often/when the report is to run, and then click Next.
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8.

Select the time, date, and how often/when that the report is to run, and then click Next.

9.

Enter the login information, and then click Next.
a.

In the Enter the User Name field, type your Windows login name.

b.

In the Enter the Password and Confirm Password fields, type your Windows password.

10. Enter the login information, and then click Next.
a.

In the Mail Server field, type the email server’s information (get this information from your administrator).

b.

In the User Name field, type your email address before the @ symbol.

c.

In the Sending E-Mail to field, type the email address to send the reports to. If sending the reports to
multiple addresses, separate the addresses using semi-colons (;).

11. Confirm the schedule, and then click Finish.
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